The Basics of Music Production
The Complete Guide
About This Night School Series

Just like learning an instrument and writing songs, the art of recording, arranging, and mixing takes time to learn. In this music production night school series we’ll introduce you to the basics, but you’ll need to continue to learn, practice, and develop a good ear in order to create great final mixes. Today we’ll begin with setting up your home studio. In the following weeks, we’ll show you how to record vocals and live instruments, add virtual instruments, and create a final mix.
Lesson 1
Setting Up a Home Studio

In our first lesson, we’ll take a look at the equipment you’ll need to set up a home studio. You don't have to get it all, but rather pick and choose what you'll need to record the kind of music you want to make in your home.
What You’ll Need

Before we can get to work and start learning about recording, you’ll need a few things. Recording equipment will cost you some cash, but you don’t have to spend a lot to get a lot. Here’s what we recommend:

Audio Interface

Although your computer likely comes with a microphone input port and you can buy low-grade microphones to plug directly into your sound card, you won’t achieve anywhere near a high level of quality. Additionally, built-in sound cards provide little to no control over the signal. Among other advantages, an audio interface provides you with the ability to use high quality microphones and studio monitors (speakers). When operating on a budget, expect to spend at least $150 for a decent unit. The Focusrite Scarlett 2i2, Presonus AudioBox 22VSL, and Native Instruments Komplete Audio 6 all provide two microphone inputs and good recording quality.
without a high cost. If you need four inputs but can’t spend much, look at the Presonus AudioBox 44VSL or the MOTU 4pre. Those with more room in their budget should consider the MOTU Track16 and MOTU 896mk3, as well as the Apogee Duet and Quartet when working on a Mac. Any interface on this list will work well so long it is compatible with your computer. Check the system requirements before buying.

Microphone(s)
If you plan to record vocals or live instruments, you’ll need at least one microphone. Most microphones record certain instruments and sound types better than others. For example, the Shure SM-57 is a popular choice for recording snare drums (although it has other uses, too) and the AKG 535 EB produces great vocals. You can get very specific about your mic choices, but since we’re just starting we want to find an inexpensive yet versatile option. Most any condenser mic with a cardioid pickup pattern (we’ll discuss what this means in later lessons) in the $100-200 range will
work. On the extremely cheap side, the Behringer C-1 and Samson C01 (which we use for our podcast) produce quality recordings for under $100. For more money, the Shure SM-27-SC and Rode NT3 will offer a cleaner, better sound under more circumstances. (In most cases you’ll benefit more from recording in a quiet, echo-free room than you will from spending hundreds on microphones, but we’ll talk about that more later.)

**Studio Monitors**

Not to be confused with computer monitor that displays a picture, studio monitors are speakers that do their best to represent recorded sound as cleanly and accurately as possible. If you’ve never heard music through a pair of even decent studio monitors, you might be blown away by the detail they provide. Even better, you can get a good pair for a reasonable price—much less than you’d pay for high quality entertainment speakers that, most of the time, don’t sound as good. The Samson Resolv A6 cost $250 for a pair and work great. For a little more money, look at the Yamaha...
**HS50M** for $150 each (you need to buy two). For a step up, consider the **Yamaha HS80M** for $250 each (you also need to buy two of them). Regardless of what you get, you should also invest in a pair of monitor isolation pads so the sound quality of your monitors aren’t negatively affected by the surface you place them on.

---

**MIDI Keyboard/Controller**

If you plan to use virtual instruments in your arrangements, you’ll need a MIDI keyboard to play them. These come cheap, and you don’t need anything fancy in most cases. For under $100, you can pick up the **M-Audio KeyStation 49** for a compact keyboard that connects over USB. For a few more keys, get the **M-Audio KeyStation 61**. These keyboards only provide basic controls, however, so if you plan to manipulate your instruments (a common need in electronic music) you’ll want something like the **M-Audio Oxygen 49** instead. For those who intend to include a realistic piano, you’ll need to cough up quite a bit more money for a good
digital one. Most digital keyboards have semi-weighted keys that respond to how hard you push them, but actual pianos are a bit more complex. A semi-weighted keyboard will not feel natural to a pianist so those who want a realistic feel and representation of a piano need to purchase a full 88-key keyboard that incorporates a graded hammer effect. For a long time, the Yamaha P series has been one of the best values. If you plan to use a virtual piano in your work, get the **Yamaha P105B**.

**MIDI Interface (Optional)**

Every keyboard mentioned in the previous section offers USB MIDI output so you don’t need a MIDI interface to connect them to your computer. Some keyboards, however, only provide traditional MIDI ports. Some of the audio interfaces mentioned earlier (such as the **Focusrite Scarlett 2i2**) double as a MIDI interface and provide MIDI inputs, but if you need a separate device the **E-Mu Xmidi 1X1** is about as cheap and simple as it gets.
Cables
You’ll need a few cables to connect all your hardware. Generally anything USB-based comes with a [USB-A to USB-B cable](#), so you probably won’t need to buy any of those. Microphones, on the other hand, use an XLR interface so you will need to purchase an [XLR cable](#) for each microphone you buy. Your studio monitors will also need cables to connect. Most work with XLR just fine, but your audio interface may only allow you to use [1/4"
[TRS cables](#). Check the output options on your audio interface and the input options on your studio monitors to ensure you get a pair that’ll work.
Digital Audio Workstation (DAW) Software

You can buy all the hardware in the world, but if you don’t have recording software you can’t do much with it. When it comes to picking a DAW, you have many options. In this series, we’ve chosen Cubase because it’s powerful, runs on both Windows and OS X, you can get a free trial, and you can buy the entry level version (which offers plenty of power and features) for under $100. You don’t have to use Cubase to follow along with these lessons. We’ll stick to broad concepts as much as possible and most DAWs work in a similar fashion. If you want to look at other options, check out Reaper (only $60), Pro Tools, Digital Performer, FL Studio (Windows only), Cakewalk SONAR (Windows only). Mac users may also want to look at Logic Pro 9, but we’d recommend against it as Apple seems to consider Logic a very low priority and nearly all the competition offers a comparable feature set for less money.
Virtual Instruments

Most DAWs come with a few low-quality virtual instruments but you’ll probably want to upgrade to something better if you intend to use them regularly in your recordings. You can find some good, free options on DSK Music and VST Planet—or just by searching the web for the specific instrument you need. If you want to recreate the sound of a piano or any other real instrument, however, you’ll need to pay—sometimes a lot—for the best. You can build out a large library of sounds quickly by purchasing a software sampler. We like Kontakt. It runs a hefty $400, but comes with several pianos, a decent orchestra, plenty of acoustic and electric guitars, a choir, electronic instruments, and a ton more. For even more sounds you can purchase Goliath for $495, but East West (its creator) has frequent sales and offers it for much less. (At the time of this writing, you can get Goliath at 50% off.) East West offers plenty of great other virtual instruments, so check them out and come back for our virtual instrument lesson to learn about additional options.
That’s a long shopping list, but nevertheless the minimum you’ll need to do some pretty standard stuff. Of course, you won’t need everything so only buy what you intend to use. If you want additional recommendations, read our inexpensive home recording studio buyer’s guide.

**Set Up Your Studio**

For the most part, setting up a home recording studio just requires a lot of plug-and-play. Nevertheless, you’ll need to know a few things to get started.

**Pick a Quiet Room**

Ideally you’d record in a room that lets in little to no outside noise and you’d acoustically treat that room to remove any reverberation.
Realistically, however, you’re going to record where you can because you don’t have the thousands of dollars necessary to set up a professional recording environment. Carpeted rooms work best, and the fewer windows you have the better. If your walls produce too much reverberation, you can hang dense blankets on them to reduce the effect. Closing the shades on your windows also helps. You won’t be able to fix all your sound problems, but choose a carpeted room and reduce as much reverberation as you can before you start recording.

Set Up Your Studio Monitors

Place one on each side of your computer display, on top of their monitor isolation pads. The angle at which you place your monitors greatly affects how you hear the sound they produce, so don’t just position them straight forward and call it a day. Instead, follow these steps:

1. Start by placing each at a 45 degree angle facing inward. (If your monitors are a good five feet away, however, a 35 degree angle will make a better starting point.)

2. Sit at your workstation and imagine a line coming out of each monitor in the direction their facing. The lines from both monitors should pass through each ear (left and right, respectively) and intersect around the back of your neck. If this isn’t the case, adjust each monitor until it is.

3. Play a monaural audio track (like this or most podcasts) and listen carefully. If the audio appears to coming from straight in front of you, you’re good to go. If it feels too far to one side, adjust your monitors
slightly until it does. Because you won’t always sit in the exact same position, the balance of sound might feel a tiny bit off if you have good ears. That said, a little bit of variance shouldn’t make a big difference. Just do the best you can to center the sound.

You may want to calibrate your monitors as well. That’s a complex topic we don’t have time for in this lesson, but read this tutorial if you want to pursue calibration.

**Enable Phantom Power for Your Microphones**
In order to record you’ll need to enable phantom power for your microphones on your audio interface. Nearly all condenser microphones with a cardioid pickup pattern—the kind we recommended you buy—require a power source (specifically, 48V). Your audio interface can provide it, but you often need to press a button or flip a switch. Consult your interface’s manual if you can’t find a button or switch labeled 48V on the front panel next to each mic input.

**Plug Everything In and Install Your Software**
Once you’ve handled the previous steps, you just need to plug everything in and install drivers and software. Depending on the hardware and software you chose, the setup process will vary. In many cases, after installation you won’t have to do anything else (aside from authorizing your software, perhaps). If not, consult your manuals to find out what additional steps you need to take to get up and running and perform a test recording in your DAW software to ensure everything is good to go.
Lesson 2
Recording Audio

After setting up your home studio, you need to know how to use it! This lesson will start you off on the basics of recording and getting used to your DAW software.
What You'll Need in This Lesson

If you’ve finished the first lesson, you should have all the equipment you need to get started. This is the equipment (and other stuff) you’ll need to have to participate in this lesson:

1. Your computer with the DAW software of your choice installed (we’ll be using Cubase)
2. A digital audio interface (with 48v phantom power) hooked up to your computer
3. A microphone connected to your digital audio interface, most likely via XLR cable
4. An instrument (e.g. a guitar, your voice, etc.)
5. About 20-30 minutes of your time

Once you’ve got everything ready, boot up your DAW software and let's get started!

Get to Know Your DAW's Interface

Interface elements vary between different DAWs, but they embody the same ideas. We'll use Cubase to demonstrate here, but if you're using something else you should find things are pretty similar. Let's take a look at the common parts you'll need to know about.
The main project window is where you'll do a lot of your work. This window lets you interact with your instruments and sounds as well as bring up individual channel settings as needed. You can do a lot more, too, but those are the basics.
The mixer (in Cubase, this is the first of three mixers) looks like a hardware mixing board in a lot of ways. You can adjust the levels of individual tracks, open their channel settings, monitor the master output, and keep a general eye on what's going on with your mix as it plays.

The transporter does what you probably expect: it transports you around your project. This is where you press record, stop, and play, but also where you can toggle the metronome, set time signatures, loop your project, and get information about where you currently are in your project.
The VST instruments panel isn't something you really need to know about until the next lesson, but it's simply where you add virtual instruments to your project.
When you click the little "e" button next to an audio track you get its channel settings. You can add input (track-specific) and send (multi-track) effects here, use the built-in EQ, and adjust gain.

Those are the main elements of the interface you need to know about. Read on to learn how to set up your first project!
Set Up Your First Project

You already know how to record audio if you know how to push a button, but digital audio workstation (DAW) software requires some setup before that big red circle will actually capture an audio signal. Although we'll be using Cubase to set up our project, most DAW software works in similar ways. If you're not using Cubase, you should be able to follow along just fine but will need to look in slightly different locations for menu items and certain buttons. Here's what to do:

1. To get started, create a new project by selecting New Project in the File menu. Select "Empty" as a project type. Cubase will ask you where to save it, so pick one and wait for everything to load.
2. Before you can start recording, you need to make sure Cubase (or whatever DAW you’re using) can find your interface and the mics (or whatever else) you have hooked up to it. Go to the Device menu and choose VST Connections.

3. From there, click the Inputs tab and set the first mono input to your first microphone. Repeat this process for any additional microphones or inputs (e.g. electric guitars).

4. Click the Outputs tab and you should see a pair of stereo outputs. Set the first one to your left speaker and the second one to your right speaker.

5. Now that your inputs and outputs are properly routed, close VST Connections and go to the Project menu. Choose Add Track -> Audio.

6. When the new track window appears, create one track and set its configuration to mono. Because we’re just recording from a single microphone in this lesson, you don’t need a stereo track. In fact, you’ll rarely choose stereo even when recording from two microphones because you’ll likely prefer to have the channels separated. This provides you with greater control over where they’re placed in the recording (i.e. where it sounds like the recorded voice or instrument is) and the character of the sound. When you’re done, click Add Track.

7. By default, the new track should have its record enabling toggle button lit up red. You’ll see this beneath the track name. If it isn’t lit, click on it to enable recording on this track.
8. Also by default, your track should be set to your first microphone. If not, take a look at the panel on the left side of the main project window and you'll see input and output settings. The output should be set to Stereo (which is the default name for Cubase's stereo output) and then input should be set to whatever you named your first microphone (usually Mono In by default, but this can vary). If you see No Bus that means nothing is connected to this audio track, so click on No Bus and change it to the name of your first microphone.

9. Using the transporter—which is the thin horizontal window strip with lots of tools and buttons on it—press the record button. You'll see the recording start. Talk, sing, or play an instrument into the microphone and the waveform of your audio will appear in real time.

10. When finished recording, press the stop button on the transporter.

That's all there is to it! You've just recorded your first bit of audio. It probably sounds bad, but that's likely due to a need for EQ, higher gain (increase in the amplitude of the frequency so it sounds louder), or some other problem. We're not going to worry about that just yet because you're still getting used to how your DAW works. We'll tackle mixing individual audio tracks and the entire mix in a later lesson, though you can get a preview if you watch the video above.
Lesson 3
Using Virtual Instruments

You can create some awesome tracks with recorded instruments, but you can do so much more with virtual ones. Implementing them into your music allows you access to all sorts of sounds you otherwise wouldn't have, from blips and beeps to an entire orchestra.
What You'll Need in This Lesson

Here’s what you’ll need to complete the virtual instruments lesson:

1. Your computer with the DAW software of your choice installed (we'll be using Cubase)
2. A digital MIDI keyboard hooked up over USB or through a MIDI-to-USB interface
3. Virtual instruments of your choosing (a piano is a good, simple one to start with)
4. About 30-40 minutes of your time

Set Up an Instrument

Before you can play and record with a virtual instrument, you need to set one up. To do so, follow these instructions:
1. Open up the Virtual Instruments panel in Cubase (or its equivalent in your DAW software of choice) by going to the Devices menu and choosing Virtual Instruments.

2. Click one of the empty spaces to choose from virtual instruments you've installed to load it up. (We recommend starting off with a piano for your first instrument because it isn't complicated.)

3. By default, Cubase will ask you if you want to automatically create a MIDI track for this instrument. In many cases you will want to do this, but because we're learning how to set things up you should decline this time. Instead, go to the Project menu, choose Add Track, and then choose MIDI.

4. By default you'll create just one MIDI track, so unless you want to make multiples you can just press OK and let Cubase make the track.

5. You'll see the track pop up in the main window. Click on it if it isn't already selected and look at the settings to the left. You should be able to set the track's input and output. By default, the input will be set to "All MIDI Inputs." This is fine if you're only using a single MIDI input or only one input at a time. If you and another are playing jointly, you'll want to set this to a specific input by clicking on it and finding the one you want. As for the output, set it to the instrument you want to use for that track.

6. If your output only hosts one instrument, you're all set. If you're using a virtual instrument capable of hosting multiple instruments (e.g. a sampler like Kontakt) you also need to tell the MIDI track which MIDI
channel to use. Underneath the output, you'll see an option to select a channel. Select the channel that corresponds with your desired instrument. (If you go into the instrument's settings panel you'll see

7. Press the record button on the MIDI track to enable recording and try playing a note on your MIDI keyboard. You should see the MIDI track respond visually on screen and also hear the note played through your speakers. If you don't hear the note, you may have chosen an instrument that has a limited range. Try a few more on different points on the keyboard to make sure you're pressing a note that actually has a sampled sound attached to it.

This may seem like a lot, but it's actually very easy to set up a track once you get the hang of it. That said, it can be a little frustrating to follow text-based instructions. With all of these lessons, you'll learn everything a lot more easily by watching the included video because you'll be able to see all the settings described in these steps.
Once you've set up your tracks, you can just hit the record enable button to start playing the instruments you've connected to them. You don't have to do much else to play. Similarly, just press the record button on the transporter panel to start recording anything you play just like you did when recording a microphone in the previous lesson. When recording, it helps to use something called a click track to keep time. Basically, a click track functions just like a metronome. In Cubase, and many DAWs, you can turn it on and off with a single click in the "CLICK" section of the transport panel.
When you’ve finished recording, you may want to edit the MIDI data to fix mistakes and other issues. Just double-click on any recorded track to see the notes and their positions. They appear like an old fashioned piano roll (pictured above) and you can drag the front and back end of each note to adjust when it should be played. You can also use a function called Quantize to automatically correct notes played at the incorrect times. In Cubase, select the notes you want to fix and press the letter Q on your keyboard. It will attempt to fix your timing issues. This can, however, make your music sound robotic so you should avoid quantization whenever possible. That said, it can serve as a helpful tool for correcting mistakes when stiff perfection is what you’re going for. For more information on quantization, check out the video lesson.
Lesson 4
Mixing

The most difficult part of making your music sound good is achieving a good mix. While it'll take a lot of practice to become great at mixing, this lessons discusses the basics so you can get started on the right foot.
What You’ll Need in This Lesson

Here’s what you’ll need to participate in this lesson:

1. Your computer with the DAW software of your choice installed (we’ll be using Cubase, but you can use whatever you like)
2. Your ears
3. 30 minutes of your time, plus a lifetime of practice ;)

Use EQ to Clean Up and Even Out Your Mix

When putting a mix together, your DAW's built-in equalizer (EQ) or an equalizer plug-in will serve as your main tool. Equalizers come in several varieties, but you’ll come across four-point EQs most often. That means you have four central points where you can alter different frequency ranges: lows, low-mids, high-mids, and highs. When you adjust these ranges, you can change the character of your sound dramatically. In this section, we’ll discuss how you can use that to your advantage.

If you’re just recording some guitar and vocals, you won’t need to do much work with the EQ because your mix isn’t complex. When you have lots of instruments, their recordings often share frequencies that mix with each other and can make your mix sound muddy (i.e. everything blends together too much and instruments lose a lot of their distinct qualities). In that case, you can use your EQ to downplay certain frequencies. For example, in pop songs you’ll often find a piano stripped of its bass a little bit to let other bass-heavy instruments (like some drums or a bass guitar) claim prominence in that part of the mix. You’ll find many instruments,
including voice, like to muddy up the mid-range because most instruments make the most sound in those frequencies or at least spill into them a little bit. You can use EQ to decide which sounds dominate which frequencies so they all can have a distinct voice while still working together in harmony.

Here's one important thing to remember when utilizing EQ: lower frequencies rather than boost them. When you boost them up, you run the risk of a mix that's too loud and needs quite a bit of fixing in the end. When an instrument sounds too soft, lower the gain of the louder instruments. When you need to boost a specific frequency for an instrument, lower the ones you don't want to boost instead. This will make your life much easier in the end.

Find Balance in Stereo Channels

When we first started recording audio, we recorded a single channel. That meant everything sounded like it came from one central point, which didn't sound perfect because we don't hear that way. We have two ears, so why shouldn't we have two channels of sound? That's the purpose of stereo—to create a more realistic recording. Of course, if you abuse the privilege of stereo you can end up with some unsettling mixes. You want to aim for balance.

Balance gets tricky, however, as if you just center all your recordings you basically end up with a mono track. Stereo sounds better because you can virtually place different instruments in a "room." If you pan one guitar to the left channel entirely and another to the right, you get different sounds
in each ear but still achieve balance. You will want to center some sounds. Traditionally, vocals get stuck in the center because they are the central focus of the mix. Other instruments don't have a single stereo placement because they're large and need to span both channels. Pianos tend to take up both channels with the bass notes all in one leading up to the treble notes all the way in the other. Drum kits get messy when you mix them to the center, so you move different drums to different parts of the mix (most often respecting their actual placement on the physical drum kit).

Basically, you have two big goals when working with stereo: create a fairly realistic representation of where the sound would actually exist in a room if you were listening to it live, and to keep the left and right channels mostly balanced. If you can do those two things, you're off to a great start.

**Practice, Practice, Practice**

Mixing consists of a lot more than what we've discussed in this post and the (more detailed) video above. You need to practice a lot if you want to get better. Take a mix, listen to it on different speakers and headphones, ask friends to do the same, get feedback, make adjustments, and repeat the process. You'll learn the best by listening to your own mixes through different reference speakers and headphones, but your ears aren't the only pair of ears on the planet and they're certainly not the same as everyone else's. The more information and reference points you have, the more you can learn how to adjust your mix to sound like something everyone can enjoy. Sometimes a lot of information can screw you up, however, so make
small adjustments and test them first. You'll always make mistakes, but with lots of practice you'll learn what sounds right.

Don’t forget, this is mostly a video lesson. [Watch it here.]
Want to Learn More?
These lessons serve as a basic introduction to music production, not a complete course. You'll need to learn more through practice, but additional resources can help as well. Here are a few we recommend:

- **Lynda.com**: Lynda offers plenty of in-depth lessons on all kinds of software. If you're looking to learn more about Cubase or any other DAW, they'll likely have you covered. While it costs a minimum of $25 per month, that's a low price to pay if you're only going to subscribe for a month or two and get a few lessons. I've learned a lot through Lynda and consider it one of the best video lesson sites online.
- **Mixing Secrets for the Small Studio**: Regardless of the software you use, the most important skill you can have is the ability to mix. This book will help you learn a solid mixing skill set.
- **Gearslutz**: When you have a question during the learning process, this message board is the place to go. Even if you don't have a question, you can learn a lot from reading what others have asked in the past.

Good luck learning! Go make some great music!